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Monitor Color Correction

Every monitor is different — they each have their own unique “fingerprint.” As monitors age, their performance
degrades due to phosphors fading and liquid crystals wearing out. As a result, the colors on the monitor look
different. The single biggest cause of poor visuals on a monitor is the lack of color correction.

With more than 25 million people expected to own digital cameras by the end of year 2007, users are
embracing the convenience of self-correcting and re-touching images with easy-to-use software and photo
printers, according to a September 2005 Info Trends/CAP Ventures report. Pantone, Inc. recognizes that people
are often disappointed in the appearance of their images both on-screen and in print. You wonder if your screen
is to blame and if you can really trust what you see on-screen. PANTONE huey™ is designed to automatically
adjust and correct the way your monitor displays color and in the end, provide you a monitor color you can trust.

Two leaders in the world of color, Pantone and X-Rite have partnered and created huey to deliver professional —
quality monitor calibration tools that make it easy for anyone to get the best possible color fidelity. huey is the first
product that will automatically adjust color and contrast settings on your display if the lighting in your room should
change. By first measuring the color produced by your display, and then adjusting the color settings to a common
industry standard, huey provides improved color accuracy for digital images, publishing, online gaming, e-
commerce and Web surfing.
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Key Features of huey

¢ Innovative design, lightweight, ultra-portable device — smaller than a pen

e The only calibration device at the breakthrough price that continually adapts a monitor for changing room
lighting. A special sensor detects changes in room lighting and automatically adjusts the monitor for
optimal viewing. huey knows that as room light gets brighter, more details get “washed out” in dark areas
Provides fast measurements for quick profiling

Applies users’ personal preferences for viewing accurate color

Intuitive software interface

USB powered

What You Get

1. huey colorimeter

2. Desktop cradle

3. USB extension cable

4. Klear Screen monitor-cleaning packet and 4x4 Micro-Chamois cloth
5. Software CD

6. huey Quick Start Guide
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System Requirements

Windows®: Windows 2000, Windows XP, & Windows Vista™ operating systems
Macintosh: G4 or faster PowerPC; Intel Mac. Mac OS X 10.3.9 or later,

What’s what on huey?

Status LEDs Suction cups

%

Light sensors

Room lighting
sensor

"

Sensor mount ——

Cord Wrap
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Before You Begin

In preparation for using huey, you will need to ensure that you have a clean monitor surface. Use the cleaning
pads included in your package to wipe clean the surface of the monitor you will be calibrating.

¢ Remove moist Klear Screen cloth from packet and gently wipe entire screen.
¢ Then immediately polish the screen with the 4x4 blue Micro-Chamois cloth until screen is dry and clear.
¢ Wipe and polish in straight lines only — side-to-side and top-to-bottom.

The suction cups on huey pick up lint and dirt easily. Simply wipe them with the same cleaning pad used on
your monitor. If the suction cups are not clean, huey may fall off your monitor. If the sensor should slip during a
measurement, simply click Cancel and then restart the program.

Note: Throughout this document you will find the following terms being used:
¢ huey - refers to the device itself

¢ huey software — refers to the huey software (versions 1.0.x) with the red packaging and icon
¢ hueyPRO software — refers to the new software (versions 1.5.x) with the green packaging and icon
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Software Installation

1. Installing the software (be sure that huey is not plugged into your computer)

Place the software installation CD into your CD-ROM drive and follow the step-by-step instructions to install the
software. If the software was downloaded, click on the installer and follow the instructions. (For Mac users just drag
the huey icon onto your hard-drive.)

2. Plugging in the sensor
Note: The sensor measures your display’s color with its three light sensors, one each for red, green and blue.
Plug the sensor into any available USB port on your computer. Use the extender cable if necessary.
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Step-by-Step Instructions

Note: Your monitor should be turned on for at least 30 minutes before you begin profiling. For best results, be
sure there is no direct sunlight or room light shining on your monitor.

Step 1

Start the huey/hueyPRO software. When you first launch the software you will see a small window on the right
hand side which is the help section to guide you with each step. If this window is closed, click on the “?” to open
it.

Click on “START”

huey P2

MONITOR COLOR CORRECTION

PANTONE'
/X-Rite

|

Welcome to
hueyPRO

P Thank you for choosing
hueyPRO. 2 |
= Have you registered yet?

MONITOR COLOR CORRECTION Regiztration gives you

accesss to the latest
hueyPRO product
information and software
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/X-Rite ) _
Click Here to Register
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Step 2

Select what type of monitor you have by clicking on the small circle under the appropriate image, when the
circle is selected it will light up.

Your options are: LCD/Laptop or a CRT and then click “NEXT.”

PANTONE' | @

/ X-Rite

Display Adjust Measure Finalize
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Step 3

Place the sensor into the cradle for ambient light measurement and click “NEXT.” Place the sensor in the cradle
so that the LEDs are facing you. huey will measure the ambient light to prepare the system for calibration.

PANTONE
/X-Rite

Display Adjust Measure Finalize

Note: The ambient light sensor is for adjusting your monitor’s contrast according to the room lighting
conditions. This helps the display look the same as light changes throughout the day. The sensor measures

the ambient light before profiling.
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Step 4
This step is different for huey software and hueyPRO software.

hueyPRO software - You will be asked to do a small contrast and brightness measurement. If you see 3 rings in
the upper left quarter of the circle and 2 rings in the upper right quarter of the circle, select “Yes” and “NEXT". If
you do not see the rings select “No” and “NEXT” and follow the instructions to set your contrast and brightness.

PANTONE

/ X-Rite

Note: huey software: If you have a CRT monitor you will be asked to perform this step.

If you have a LCD monitor or a laptop please go to Step 5. This feature is only available for CRT monitors.
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Step 5

Place huey on the display as shown below and click “NEXT”. For LCD monitors and laptops gently press huey
onto the screen so the suction cups stick to your screen as shown in the display below.

Note: The suction cups will not harm your LCD or laptop display. They do, however, easily attract dust and lint
that will keep them from adhering to your display. If this happens and huey falls off your monitor, simply wipe
the suction cups with a wet cloth or cleaner.

PANTONE
/X-Rite

Display Adjust Measure Finalize
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Step 6

hueyPRO software will measure 29 different color patches (huey software measures only 26 patches). You can
see the measurement progress on the left. The measurements will take less then two minutes.

errreeeee
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Step 7
When the measurement process is complete, return huey to its desktop cradle.
Click “Next.”

Note: When huey is not in use, always place it in the desktop cradle. This will help keep the suction cups lint
free and the ambient light sensor facing the same direction as the monitor to adjust for room light changes.
When inserting huey into the cradle, be sure to insert the cable end first. Extra cable can be wrapped in the
base. Inserting huey into the cradle with the sensor side down might damage the padding surrounding the
sensors. Wrapping with the sensor up and then reclining the sensor may result in pulling the cable out of the
Sensor.

PANTONE'

I X-Rite

Start Display Adjust Measure Finalize
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Step 8

After successfully calibrating your monitor you can see the before and after by simply switching between “Show
corrected” and “Show uncorrected”. Click “NEXT” once you have studied the differences.

PANTONE'

[ X-Rite

Adjust Measure Finalize
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Step 9

For hueyPRO software, input a profile name to easily locate the profile on your system. The software will

automatically store the profile in its appropriate location on your system as follows:
e Windows operating system: C:\WINDOWS\system32\spool\drivers\color

e Mac operating system: Your Home Folder/Library/ColorSync/Profiles

ICC Profile

PANTONE RN

| hrirgPeet V0307
finu sy st B 0 b inchuid i th ICC Profs sass in e sdi. bex abs

Note: For huey software, the profile will be stored automatically with a default name, for example
“hueyViewSonicG810.icc”.

14
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Step 10

This step is different for huey software and hueyPRO software.

For hueyPRO software:

Before you are finished, the hueyPRO software will prompt you to select your color settings.

“Color Temperature” and “Gamma” settings are independently changeable with separate pull-down menus as
below:

PANTONE |

| X-Rite

continued on the next page...
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Step 10 - continued

PANTONE

| X-Rite

Color Setting Choices
The settings you choose depend on how you use your computer and monitor.

o Temperature Setting: Warm (5000 K), Neutral (6500 K), and Cool (7500 K) - Color setting/ balance
refers to the "shade" of white displayed on the screen. Color temperature is measured on the Kelvin
scale. This describes the color of light emitted by a glowing element heated to the specified
temperature. The higher the color temperature, the cooler (bluer) the light. The lower the color
temperature, the warmer (redder) the light.

e Contrast Setting: Low (gamma 1.8), Medium (gamma 2.2), and High (gamma 2.4) - Contrast refers to
the difference between light and dark objects on-screen. Technically, contrast is measured by gamma,
the relationship between input and output signals. Higher gamma settings will result in a darker screen
with more contrast. The lower settings will provide a brighter screen with less contrast.

Suggested setting for use | llluminate (color temperature) | Gamma
Gaming 6500 K 1.8
Web Browsing & Photo Editing 6500 K 2.2
Graphic Design & Video Editing 6500 K 24

16
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Step 10 - continued
This step is different for huey software and hueyPRO software.
For huey software:

Before you are finished, the huey software will prompt you to select your color settings according to your
primary viewing activity such as looking at photos, playing games, browsing the Web, etc. Your monitor will be
adjusted based on your choice.

Select Setting

PANTONE |03}

faretagmacbeth

Graphic Design & Video Ediling
Warm, Low Costrast
1vvarm, Mediuom Contrast
Warm, High Contrast
Ceol, Low Contrast
Ciol, Medium Contrast
Cool, High Conlrast

Color Setting Choices

You can choose one of nine pre-defined settings that control your monitor’s contrast and color balance. The
settings you choose depend on how you use your computer and monitor.

e Temperature Setting: Warm (5000 K), Neutral (6500 K), and Cool (7500 K) - Color setting/ balance
refers to the "shade" of white displayed on the screen. Color temperature is measured on the Kelvin
scale. This describes the color of light emitted by a glowing element heated to the specified
temperature. The higher the color temperature, the cooler (bluer) the light. The lower the color
temperature, the warmer (redder) the light.

e Contrast Setting: Low (gamma 1.8), Medium (gamma 2.2), and High (gamma 2.4) - Contrast refers to
the difference between light and dark objects on-screen. Technically, contrast is measured by gamma,
the relationship between input and output signals. Higher gamma settings will result in a darker screen
with more contrast. The lower settings will provide a brighter screen with less contrast.

Color Setting Choice llluminate (color temperature) Gamma
Gaming 6500 K 1.8
Web Browsing & Photo Editing 6500 K 2.2
Graphic Design & Video Editing 6500 K 24
Special: Warm, Low Contrast 5000 K 1.8
Special: Warm, Medium Contrast 5000 K 2.2
Special: Warm, High Contrast 5000 K 24
Special: Cool, Low Contrast 7500 K 1.8
Special: Cool, Medium Contrast 7500 K 2.2
Special: Cool, High Contrast 7500 K 24

17
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Step 11

You will be prompted to select if you would like huey to adjust your monitor for room light changes. Select “Yes”

or “No” and click “FINISH.”

ey PRO has successiolly caltrated yoor deplay

Betsiy L e ver SCroean At Boest warwing whin Hha soom
bghet changes

erFmMTMMIM?

PANTONE [E3)

1 NsRita

7 BACH FBUSH

Note: hueyPRO software users if you have multiple monitors, continue to the next step.
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Step 12

Multiple Monitors

This feature is only available in hueyPRO. If you have multiple monitors you will be asked if you would like
additional monitors calibrated and if so, drag the hueyPRO application window to the other monitor and follow
the same steps to calibrate your additional monitors.

Mulliple Displays

-

—

PANTONE |#3)

A NPt

W Barvw s=ote- than Sed deigliy atlachad To Calibrane wsothe: driplay. deag -
Jwimcigm §o the tepd ba [ calbuntad or YOm may gock Uy penasing

T

Note: All monitors will be set to the same ‘Color Temperature’ and ‘Gamma’ settings for increased consistency.
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huey/hueyPRO Preferences

Your settings can easily be changed after you have completed the color calibration process through the
Preferences menus (available from the huey/hueyPRO icon in the system tray on Windows or on the menu bar
on a Mac) without re-measuring your monitor.

Click on the huey/hueyPRO icon.
e Red icon for huey software
e Green icon for hueyPRO software

&)'_ B == ® 127rM
|

Select “huey/hueyPRO Preferences.”
Start huevPRO
Turn QOFf Room Lighting Compensation
Reset hueyPRO /
hueyPRO Preferences

About This Program
Reqister MNow
Adjust For Room Light Mow

Check Far Updates

Exit

huey/hueyPRO Preferences window will be displayed on your monitor.

The next few pages have additional information about “Room Light Monitoring”, “Settings” and “Reminders.”

Note: huey software does not have some of the features that are discussed in section.

20
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Room Light Monitoring:
You can switch on/off the ambient light measurement feature.

You can set the room lighting monitor to a desired interval from 10 seconds to 4 hours. For optimum ambient
light adjustment, position huey in its cradle with the ambient light sensor facing in the same direction as the
monitor screen. The ambient light sensor is on the same side as the indicator LEDs and logo.

hueyPRO Preferences E

Fioorn Light Monitaring |Selﬁngs| Reminders |

[v Adjust for room light changes.

Room light compensation adjusts vour display io be
suitable to the ambient light level inthe room,

Adjustment Frequency (1 Minute)

(] " -\I " . . ' ' . i
-

More Frequent Less Frequent

This contrals how often hueyFRO measures the room
lightimg.
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Settings:
You can switch from “Corrected” to “Uncorrected”.

You can change your “Color Temperature” & “Gamma.”

hueyPRO Preferances E

Fioorm Light Monitoring  Seftings |Fteminders |

* Corected " Uncomected

Color Temperature: | i j
The Color Temperature seting controls the whita point of wour display.

Gamma: [2 20 j
Gamma controls the contrast of vour display.

Note: huey software does not have separate “Color Temperature” and “Gamma” controls. However similar
settings are available under the predefined settings in the pull down for “Color Settings.” Also see Step 10 for

more information on “Color Settings.”

22
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Reminders:

Turn on/off the reminder to re-calibrate your monitor as well as setting the reminder to recalibrate your display.
Note: This feature is ONLY available for huey/hueyPRO software.

hueyPRO Preferances

Rioom Light Monitoring | Setings  Reminders |

[v Femind mawhean calibration is due.

hueyFRC can remind you when to recalibrate. ou can
change the number of days before you are reminded.

Dews Between Reminders b days
| |
* Fawer Denys kore Days

This controls how many days may elapse before wou are
reminded to recalibrate your displays.

Note: huey software does not have this feature.

23
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Advanced Help Section

The following section will help you better understand some important questions you may have about your
monitor, different characteristics of your monitor profile, what you have to do once you have calibrated and
profiled your monitor, etc. We have designed this section in the form of questions and answers. All you have to
do is click on your question and it will take you to the answer. If you still have additional questions and require
further assistance, you can contact us at: www.askpantone.com.

Questions are sectioned into the following categories:

Basic Color Management Questions

Monitor Calibration

After Calibrating

Printing

24
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Basic Color Management Questions

1. What is Gamma?

What is Whitepoint?

What is the difference between luminance, contrast and brightness?
What is an ICC monitor profile?

What is a ColorSync profile?

aprON

1. What is Gamma?

Monitor gamma describes the relationship between the strength of a monitor's input signal and the brightness of
the displayed image. The industry standard for the truest capable grayscale of a monitor is 2.2 Gamma. This is
the gamma that is best for viewing color images and browsing the web.

2. What is Whitepoint?

The monitor’s whitepoint is the temperature measured in Kelvin. The higher the whitepoint, 7500K — 9300K, the
brighter and bluer or “cooler” the screen looks. The lower the whitepoint, 6000K — 5000K, the less bright and
redder or “warmer” the screen looks. The ideal setting for most displays is 6500K when working with images,
photographs or browsing the Web. However, often the settings for displays when they are “out-of-the-box” are
very bright and bluish and we get used to seeing everything big and bright. In fact, this is one of the key
reasons why your screen and print do not match. The mismatch between the brightness of colors on the
monitor and color printed on your inkjet are worlds apart - it precisely is the reason that you need to calibrate
and profile your monitor, to bring what you see and what you get closer together.

Color balance refers to the "shade" of white displayed on the screen. Technically, Color temperature is
measured on the Kelvin scale. This describes the color of light emitted by a glowing element heated to the
specified temperature. The higher the color temperature, the brighter and cooler (bluer) the monitor will appear.
The lower the color temperature, the less bright and warmer (redder) will be the overall appearance of the
monitor.

3. What is the difference between luminance, contrast and brightness?

Luminance is the luminous intensity projected on a given area and direction. Luminance is an objectively
measurable attribute. The unit is '‘Candela per Square Meter' (cd/m2). So, different monitors can be adjusted to
the same luminous intensity by measuring the luminance in cd/m2.

To learn more about Luminance, visit: http://www.crompton.com/wa3dsp/light/lumin.html .

Brightness is a subjective attribute of light. The monitor can be adjusted to a level of light between very dim and
very bright. Brightness is perceived and cannot be measured objectively (but it can be scaled, e.g., as a
percentage).

Contrast refers to the difference between light and dark objects on-screen. Technically contrast is measured by
gamma, the relationship between input and output signals.
4. What is an ICC monitor profile?

An ICC (International Color Consortium) profile describes how your monitor reproduces color and what colors it
can or cannot produce and encodes this information. A profile can be used by any application that uses ICC
profiles to compensate for a monitor's color-display limitations. Accurately calibrating and characterizing your
monitor is the crucial first step in developing a color-managed workflow.

5. What is a ColorSync profile?

A ColorSync profile is an ICC profile used on the Macintosh Operating systems.

25
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Monitor Calibration

1. What is monitor calibration and why do | need it?

What does “calibration” mean?

Does huey calibrate and profile the monitor?

What if I’'m not using a color-managed application? Does huey matter?

What does huey calibrate to?

. Isn’t monitor calibration just for professionals?

. | have calibrated my monitor online, or using Apple Display Calibrator or with Adobe Gamma.
Why should | buy a sensor to calibrate and profile my monitor?
8. How often should | recalibrate my monitor?
9. Will the huey calibrate my laptop monitor?

10. Is it possible to calibrate/profile dual monitors with the huey™PRO software?

11. How should | position huey for ambient light measurement?

12. How does Adobe Gamma affect huey monitor calibration?

13. How do | disable Adobe Gamma on a Windows system?

14. Should I turn off the rooms’ lights before calibrating my monitor?

15. Are there graphic cards that will cause problems when I’'m calibrating my monitor?

NOOARLON

1. What is monitor calibration and why do | need it?

Every monitor is different — they each have their own unique “fingerprint” and change over time. As monitors
age, they degrade due to phosphors fading, liquid crystals wearing out and the performance is just not the
same. As a result, the colors on the monitor look different. One of the biggest reasons for poor color in your
prints is failure to calibrate and profile the monitor. huey’s sensors will analyze how the monitor emits color and
correct the display to show true color.

2. What does “calibration” mean?

Calibrating is the process of returning a device to known color conditions by manipulating brightness, contrast
and color balance. Regular calibration is necessary for displays because they shift and may change over time —
the phosphors in CRT monitors lose brightness and the dyes in LCD cells can wear out. In order to ensure that
your monitor can reproduce the optimal color gamut, you must first calibrate your monitor before you profile it.

3. Does huey calibrate and profile the monitor?

Yes, huey will calibrate your monitor first and then will take the data to create an ICC profile specific to your
monitor. huey performs 2 distinct functions - calibration and profiling. huey calibrates the monitor, adjusting it for
the display standard for images and web browsing. huey then profiles the monitor taking it one step further by
providing the fingerprint of your monitor that can be interpreted in color managed applications like Adobe
Photoshop for the highest degree of visual and color precision.

4. What if 'm not using a color-managed application? Does huey matter?

The answer is YES because it will still ensure that the monitor is displaying color as accurately as possible. On
a system level, your computer will use the profile that huey creates to control the display of color.

5. What does huey calibrate to?

huey builds an ICC profile of the monitor based on the brightness and contrast settings that are adjusted during
the profiling process. huey is unique in that it provides color settings that allow you to dynamically change the
whitepoint/gamma combination that is being used. This information is uploaded to your computer's video card
independent of the profile. In addition, during the profile process huey projects a precise series of color patches
and measures the monitor's interpretation of these colors to set the monitor's color balance properly.

26
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Monitor is Calibration - continued

6. Isn’t monitor calibration just for professionals?

No. While it’s true all professionals dealing with color-critical work do need to calibrate their displays on a regular
basis, even if you are not a graphics professional, you may be frustrated that your printouts from your inkjet
printer do not match your monitor and further, their quality is less than satisfactory. You will immediately begin
seeing the benefits of a color-corrected monitor.

Anyone who fixes red-eye or edits images, prints at home, works in graphic design, or is just frustrated wasting
time, paper and ink will get improved results and better color fidelity.

7. | have calibrated my monitor online, or using Apple Display Calibrator or with Adobe Gamma.
Why should | buy a sensor to calibrate and profile my monitor?

Online adjustments and Adobe Gamma are based solely on a person’s vision. The accuracy of someone’s
vision can vary and be affected by outside lighting. Using a sensor, which is calibrated specifically for monitor
color correction, takes the guesswork out of getting the right colors on-screen and in print.

8. How often should I recalibrate my monitor?

How often to recalibrate your monitor with huey depends upon a number of variables:

o Stability of the monitor

o Type of files that you view

o Level of color matching required
A typical user calibrates every two weeks. However, you may want to recalibrate daily, weekly or monthly. If you
notice a change in your monitor's appearance, it may be time to recalibrate. If you're demanding about color or
your monitor doesn't hold calibration very long, you may want to recalibrate weekly or even daily. If your monitor
is relatively stable or you view non-color critical documents, it may only be necessary to calibrate once per
month.

9. Will the huey calibrate my laptop monitor?
Yes, huey will calibrate all CRT, LCD and laptop displays.
10. Is it possible to calibrate/profile dual monitors with the huey ™PRO software?

Calibration of dual monitors is a feature of the hueyPRO software only.

11. How should | position huey for ambient light measurement?

huey has a sensor for adjusting your monitor's contrast according to ambient room lighting conditions. This
helps the display look the same as light changes throughout the day. huey measures the ambient light before
profiling. It can also adjust your monitor's contrast at specified intervals, from every 10 seconds to four (4) hours.

For optimum ambient light adjustment, position huey in its cradle with the ambient light sensor facing the same
direction as your monitor screen is facing. The ambient light sensor is on the same side as the indicator LEDs
and huey logo.
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Monitor is Calibration - continued
12. How does Adobe Gamma affect huey monitor calibration?

Adobe Gamma is a free, visually based monitor calibration program that is installed automatically when Adobe
Photoshop® is installed on Windows computers. Adobe Gamma can interfere with the huey calibration, which
can cause bad calibration results (color shifts, strange brightness, etc.).

Before calibrating your monitor with the huey software or hueyPRO software, you should disable Adobe
Gamma.

To do so:
e Clickon “START.”
e Click on “Programs.”
e Click on “Startup.”
¢ Right-click on “Adobe Gamma” and choose “Delete.”

For Mac OS, Adobe Gamma is not applicable.

13. How do | disable Adobe Gamma on a Windows system?

To disable Adobe Gamma on a Windows system, do the following:

1. Right-click the Start menu, and choose 'Open.’

2. Double-click Programs, then Startup.

3. Delete Adobe Gamma or Adobe Gamma Loader.exe if present.

4. For Windows 2000, XP only, repeat steps 1 - 3, choosing 'Open All Users' in Step 1.

5. Close the Startup window to return to the main screen.

Note: This procedure does not delete Adobe Gamma from your hard-drive. It merely removes the shortcut to
the startup file to prevent Adobe Gamma from loading its calibration in place of the monitor calibration solution
you are currently using.

14. Should | turn off the rooms’ lights before calibrating my monitor?

It is not necessary to do this as huey is designed to block most of the room light during measurement. It is not
affected much by room lighting, unless very bright light, such as direct sunlight, strikes the display.

Also, huey is designed to adjust your monitor for ambient lighting. When calibrating, you should set the light
level as you normally would when viewing your monitor.

For viewing photos on-screen, we recommend that room lights have balanced color temperature and are dim
enough to view the monitor comfortably. The graphic arts viewing standard specifies 5000 K lighting (however
we suggest 6500 K in our settings), which is equivalent to noon daylight. Incandescent light bulbs, warm white
fluorescent lamps, and cool white fluorescent lighting are not evenly balanced and may make prints look
differently than they do on-screen.

15. Are there graphic cards that will cause problems when I’'m calibrating my monitor?

Yes, some Radeon Series from ATl may deliver unexpected calibration results. The resulting gamma curve
may contain strange peaks and the display may show a strange color shift. The reason is that the ATI Radeon
card driver, version 4.1, has a bug. The monitor calibration software is not able to reset the gamma curve before
starting the calibration process.

This bug has been fixed by ATI. If your video card is installed on a desktop computer, you can download the
newest driver versions from www.ati.com. If you work on a notebook, please contact your dealer or the
manufacturer of your notebook and request an appropriate driver update.
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After calibrating the monitor

1. What does huey do with the profile?

. Which color settings in huey software and hueyPRO software should | choose?

. How do I tell if my monitor calibration and profile are good?

. How do | switch a monitor’s calibration and profile on the fly without rebooting on Windows?
. Why is my screen yellowish and dull looking after calibrating?

. Why does my screen appear dim compared to the native setting?

. Why do images look different in Web browsers than they do in Adobe Photoshop?

. I have calibrated my monitor. When working with Adobe Photoshop which color settings
(edit/color settings) should you choose?

9. Does an Embedded Profile Limit the Colors Within an Image?
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1. What does huey do with the profile?

After huey software creates a profile, it is automatically stored and activated in the proper systems folder
(Windows or Mac) so that it is ready to be used. For hueyPRO users, you will be prompted to name the profile
and for huey users, the software will give the profile a default name.

Windows: C:\WINDOWS\system32\spool\drivers\color

Macintosh: Your Home Folder/Library/ColorSync/Profiles

2. Which color settings in huey software and hueyPRO software should | choose?

In huey software you can choose one of nine pre-defined settings that control your monitor’s contrast and color
balance. Higher gamma settings will result in a darker screen with more contrast. The lower settings will provide
a brighter screen with less contrast.

- Color Setting (temperature): Warm (5000 K), Neutral (6500 K), and Cool (7500 K)

- Contrast Setting (gamma): Low (1.8), Medium (2.2), and High (2.4).

The settings you choose depend on how you use your computer and monitor, for example:
e Gaming (6500 K, 1.8)

Web Browsing & Photo Editing (6500 K, 2.2)

Graphic Design & Video Editing (6500 K, 2.4)

Special: Warm, Low Contrast (5000 K, 1.8)

Special: Warm, Medium Contrast (5000 K, 2.2)

Special: Warm, High Contrast (5000 K, 2.4)

Special: Cool, Low Contrast (7500 K, 1.8)

Special: Cool, Medium Contrast (7500 K, 2.2)

Special: Cool, High Contrast (7500 K, 2.4)

If you are playing computer games, you may want to choose different settings based on the type of game being
viewed. For example, players of the relatively dark game, Doom™, may want to set color to "Warm" (5000 K)
and contrast to "Low" (1.8) to better see the shadows of the dark scenery. A "Madden Football" player might set
color to "Neutral" (6500 K) and contrast to "High" (2.4) to best see the game's light, blue and green scenery. A
"Harry Potter" player might choose a color of "Warm" (5000 K) and contrast of "Medium" (2.2) to best see this
game's light and dark scenery.

In hueyPRO software you can select your own color temperature and gamma that you prefer. We recommend
you display an image in the background as you are switching through the different selections to see which
combination works best for you.
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After calibrating the monitor — continued
3. How do I tell if my monitor calibration and profile are good?

After calibrating and profiling your monitor with huey, it should look essentially neutral in color and have smooth
contrast. Depending on the type of file you are viewing, such as photographs, computer games or office
documents, check light, medium and dark areas of the screen to make sure they look neutral and do not have a
strong color cast. Examine gradients or blends if present to make sure they are smooth.

You can perform a more comprehensive test of your huey monitor profile if you have Adobe Photoshop or any
other application that is able to display photos (bitmapped images) using ICC profiles. In the following steps, you
can view the images with or without the monitor profile. To turn off the monitor profile in Adobe Photoshop,
select View > Proof Setup > Monitor RGB. The monitor profile will be off if View > Proof Colors is checked.
To turn the profile on and off, uncheck and then recheck Proof Colors.

1) Compare with an image. Open an image in Adobe Photoshop and compare it on-screen with a print. Select
an image that you have printed with a printer profile you know is good. If the print is viewed in balanced
illumination (daylight or 5000 K illumination), the image on-screen should look the same. If viewed in home
incandescent, office fluorescent, or any other lighting that is not neutral, the printed image will be off and will not
match the screen exactly.

2) Use the gradient tool in Adobe Photoshop to make a gradient from black (RGB = 0 0 0) to white (255 255
255). Examine the gradient with the monitor profile on and off (see above instructions). The gradient should be
smooth from highlight to shadow.

3) Check shadow definition. Create a series of rectangles with RGB values of 0 0 0 (black), 8 8 8, and 12 12 12.
If your monitor is properly calibrated and profiled, you should be able to see a difference between the three
rectangles.

4. How do | switch a monitor’s calibration and profile on the fly without rebooting on Windows?

Unlike Macintosh operating systems, Windows operating systems do not have 'dynamic profile loading;'
therefore, you cannot instantly upload a different lookup table to your video card.

To switch between different calibrations and profiles on Windows, you need to use DisplayProfile utility. This
freeware allows you to switch both the calibration and profile without having to reboot the computer. If you do
not use this application and just switch the profile in the display's properties window, it will load the new profile,
but not the new calibration. To download this DisplayProfile utility please Click Here. Scroll to the bottom the
page and you will find “DisplayProfile freeware for Windows.”

5. Why is my screen yellowish and dull looking after calibrating?

If you picked the "Warm" color temperature (5000 K), your monitor may look yellowish compared to its native
state that you have been used to viewing. The native color temperature of many monitors, particularly TV-tube
monitors (CRTSs), is much bluer than that of a calibrated monitor.

Both the huey software and the hueyPRO software have three settings for Color Temperature: Warm (5000 K),
Neutral (6500 K), and Cool (7500 K). The higher the color temperature in Kelvin, the bluer the display; the lower,
the warmer it is. If your display looks too yellow, you might want to choose a cooler setting.

The 5000 K "Neutral" setting was designed for graphic arts, where standard viewing conditions are specified as
5000 K. This specification was written for fluorescent light bulbs, however, which are much brighter than
computer displays. You may find that the "Neutral" setting (6500 K) produces a more balanced color on-screen.

Likewise, if you picked the "Low" contrast setting, the screen will look duller than with the "Medium" or native
settings. A setting of "Medium" may produce a more pleasing appearance.

Different settings will be appropriate for the way you are using your computer, including graphic arts,
photography, video gaming, Internet viewing and document processing.
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After calibrating the monitor — continued

6. Why does my screen appear dim compared to the native setting?

During calibration, huey/hueyPRO software creates a set of correction curves that balance your monitor's red,
green and blue signals to create a more neutral color balance and to set a numerically defined contrast. The
calibrator cannot make the monitor brighter; it can only dim channels relative to one another. So, even though
the monitor may appear dimmer than it did before calibration, it is still displaying balanced, repeatable color and
contrast.

If your monitor looks too dim after calibrating, you might want to set a higher brightness level before calibrating.

7. Why do images look different in Web browsers than they do in Adobe Photoshop?

Adobe Photoshop reads the standard working space profile embedded in images, then converts from this profile
to the monitor profile for accurate display. Some browser applications read neither the standard working space
profile nor the monitor profile; therefore, they only benefit from the monitor calibration and not the profile.

8. | have calibrated my monitor. When working with Adobe Photoshop which color settings
(edit/color settings) should you choose?

After calibration, the huey profile is stored in the operating system as the “Default Monitor Profile”. When Adobe
Photoshop is open/running the software automatically refers to the “Default Monitor Profile”, in our case the
huey profile. From the “Edit>Color Settings” menu users should mostly be using “Adobe RGB 1998 working
space for the widest possible color gamut or “sRGB” working space if they want to simulate Web colors. The
huey profile will appear above these selections in the drop-down menu; however this is just a reference to the
user showing them that Adobe Photoshop recognizes and is using the default monitor profile already. The user
does not have to change any settings in Adobe Photoshop after calibration for the huey profile to be “in-use.”

9. Does an Embedded Profile Limit the Colors Within an Image?

An embedded color profile or an assignment of a profile in Adobe Photoshop does not actually change
the data in the file; it merely tells the application how to interpret those color numbers. It describes what
red, green and blue look like and how they appear in various combinations. This does not limit the
adjustments you can make. Note: However, assigning different profiles to the same image data will
produce different results. If you start off with an image that has an embedded profile or sSRGB and then
assign it Adobe RGB (1998), the image will become much more vivid. This is because the Adobe RGB
(1998) color space is much larger than sRGB, so "red" is much "redder." If you want a full understanding
of profiles and color management, refer to "Real World Color Management" by Bruce Fraser as it covers
all the fundamentals as well as practical aspects and specific settings for various programs.
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Printing after the Monitor is Calibrated

1. I understand that huey can calibrate my monitor but how can | ensure that my prints are going
to match what | see on-screen?

2. What are "canned" profiles?

3. How are custom profiles created?

4. Should I build an RGB or CMYK profile?

5. Where to place the profile on my system?

6. How to print using a printer profile?

7. What is soft proofing?

1. I understand that huey can calibrate my monitor but how can | ensure that my prints are going
to match what | see on-screen?

huey and hueyPRO are monitor solutions only. In order to achieve 'screen-to-printer matching,' you would need
to have a valid ICC profile for your printer as well, and ensure that the profile is properly assigned at the time of
output. Many printer manufacturers make pre-made or “canned” ICC profiles available. These are often
available on the manufacturers’ Web sites or included with the printer driver software. A profile is made for a
specific printer, ink and paper. Should you change any one of those three things, you will need a different profile.

Additionally, there are also services that will allow you to submit a printed target, and will make profiles for you,
usually for a fee. (Pantone offers ColorValet, the custom ICC printer profiling service from CHROMiX. It is fast
and easy) Performing a Google™ search on 'ICC profiling' should provide you with contacts for profiling
services.

If you are sending work to a lab or service bureau, you need not concern yourself with the output. Typically, you
will embed a source profile into the image which contains the information about your monitor that is provided by
the profile which would be made with huey. It is the lab's responsibility to color-manage the file to their output
system.

2. What are "canned" profiles?

Every printer manufacturer supplies ICC color profiles that are specifically designed for the papers that
the printer manufacturer sells. For example on Seiko Epson Corporation’s website you will find ICC
profiles for the specific printer and a specific media type, i.e., EPSON PRO4000 using EPSON Premium
Luster Photo Paper. These profiles are designed to correctly print color onto this same kind of paper from
your printer. If you are printing with EPSON Premium Luster Paper, then you would choose this profile
when you print.

If you are using Moab, Arches Infinity, Red River, or any other paper manufacturers’ media you can find
profiles for their paper types on the paper manufacturers’ Website. Many times the “canned profiles” will
not give you the best color since the profiles are more “generic” and not specifically built for your printer,
its environment and your media types. Also, there can be minor differences in consistency between
different printers even if they are of the same model. So, despite manufacturer-supplied profiles with
manufacturer paper, a precise color match might not be achievable.

If you are using EPSON printers and printing with PANTONE® ColorVANTAGE?® Inks, you will find ICC
profiles at www.pantone.com.

If you are using

- Canon Printers

- EPSON Printers

- Hewlett-Packard Printers
- RedRiver Paper

- Moab Paper
- Arches Infinity Paper

- Hahnemuehle Paper
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Printing after the Monitor is Calibrated - continued

3. How are custom profiles created?

Custom profiles are made specifically for your printer. Using your printer, your printers’ ink set, your
specified media type and with a specific printer driver setting. Custom-created profiles present the highest
level of accuracy that can be achieved with printer profiles.

There are many software and hardware packages available for custom profiling. Users can build their
own profiles by printing a target provided in the package with instructions. Users can measure the targets
on the hardware that comes with the package and then use the software to build the profile. The cost of
these packages runs from $600 to several thousand dollars depending on the quality and the extent of
the features.

As an alternative to "doing-it-yourself", there are service providers who supply custom printer profiles over
the Web. There is a cost advantage to using a service provider, especially if you only need a small
number of profiles. In addition, many people find that allowing a service provider to do their profiling
makes life simpler for them. Finally, it is possible to get a better profile from a competent profiling service
than one can make oneself - without investing in several thousand dollar's worth of equipment.

The usual procedure is:
1. Download instructions and a profiling target image.
Print the profiling target image on your printer, following very specific instructions.
Mail the target print into the profiling service.
The service provider measures the target using their spectrophotometric equipment

The service provider uses the target measurement to create the profile, and emails the profile back to
the customer.

o bk wbd

If you are in need of custom profiles, Pantone offers ColorValet, the custom ICC printer profiling service from
CHROMIX. It is fast and easy. You will have to download a Web-based application program, which will guide
you through the whole process and will also manage all of your profiles.

If you are interested in purchasing your own profiling solutions visit www.x-rite.com. You will find packages such
as Profile Maker 5 Photostudio, Profile Maker 5 Publish Plus, Eye-One™ Design, Eye-One Photo, etc.

4. Should I build an RGB or CMYK profile?

It is useful to know whether your printer will be considered an RGB device or a CMYK device. This cannot
be determined merely by reading the color names of the print cartridges, or by counting the cartridges.
Most inkjet printers will use at least four standard inks: Cyan, Magenta, Yellow, and Black - yet most inkjet
printers will need to be profiled as RGB devices. Generally, if a driver is used to submit images directly to
the printer, then it should be profiled as an RGB device. If you are printing through a RIP, then you might
be looking at a true CMYK process.

5. Where to place the profile on my system?

e For Windows operating systems: C:\WINDOWS\system32\spool\drivers\color
o For Macintosh operating systems: User/Library/ColorSync/Profiles
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Printing after the Monitor is Calibrated - continued

6. How to print using a printer profile?

When you are ready to print your image in Adobe Photoshop CS2:
Step 1: Check your “Color Settings”
1. Launch Adobe Photoshop CS2 (Adobe Photoshop CS (Mac) or older the steps below may differ)
2. Go to Edit > “Color Settings...”
3. Under “Settings” select: U.S. Prepress Defaults or North American Prepress 2

Color Settings

X

Settings: | LS, Pre W |
D&d\ranced Mode
wiorking Spaces Reset
RGE: | Adobe RGE (1933) ~|
MY LS, Wik Coated (SWOP) w2 ~| Load...
Gray: | Dot Gain 20% v Save. ..
Spat: | Dot Gain 20% |
Preyisw
Colar Managerment Palicies
RGE:! |Preser\re Embedded Frofiles b |
CMYE: IPreser\re Embedded Profiles b |
aray: |F‘reser\re Embedded Profiles b |

4. Click “OK.” Now you are ready to print your image, the next few pages have instructions on assigning
printer profiles.

Once you have configured your “Color Settings,” open an image in Adobe Photoshop and follow the steps
below:
1. File = “Print with Preview...” assign your profile as shown below.

Adobe Photoshop CS
Print E‘
Position BB
Iopi[0 |[inches v =
Left: \—1 inches ~
:

Scaled Print Size

Seder [0 | [Mscale to At Media
Height: inches v
wicth inches ~|

[¥]show Bounding Box

)

[Z]1Show More Options

Color Management ¥

Source Space:
Document: (& Dacument: Untagged RGE
proof: O Proof Setup: U.S. Weh Coated [SWOP) v2

ile here...

/Assign Pro

Y ‘|

Print Space:
Profie: | EPSON Stylus Photo 1280

Intent: | Perceptual vl

[Juse Black Paint Cornpensation

Profile: use the pull-down to assign your profile
Intent: “Perceptual”
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Adobe Photoshop CS2
i = 1 Position [ Pmtoe
To0 s ] -
e |

Scaled Print Size

Fewser Options

Height: | inches E
width: ‘*‘ ,ﬁl

[¥1show Bounding Box
[IPrint Selected Area

Scale! | [ Seale to Fit Media
} 8

Print
®Document  (Profie: Untagged RGE)
OProof

Assign Profile here...

Options
Color Handing: | Let Photoshop Detemmine Colors | i//

Printer Profile; ‘ HP Desklet 1220C Prermiurm Plus ... V‘

Rendering Intert; | Perceptual | [Mlack Paint Compensation

Color Handling: “Let Photoshop Determine Colors”
Printer Profile: use the pull-down to assign your profile
Rendering Intent: “Perceptual”

2. Click “Print” this will bring you to another dialog box to select your settings within your printer driver.
3. Click on “Properties.”

4. Select the appropriate media settings and dpi for which your profile was created.

5. Ensure that you select “No Color Adjustment” in the printer driver under “Color Management.”

6. It is recommended that you save these settings as a preset as you will use these driver settings with
printing images using the profile.

7. Click on “Print.”
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Printing after the Monitor is Calibrated - continued

7. What is soft proofing?

You have a monitor profile for your recently-calibrated monitor. You also now have a well-made printer
profile that you are printing through. Your profiled monitor is presenting to you your image as accurately
as it can, given the limitations of the color gamut of the monitor. Your printer profile is printing your image
in an intelligent way so that it looks as good as it can, given your intent, and the limitations of the printer.
Monitors are capable of showing colors that printers cannot print (like saturated reds, blues and greens.)
And printers can produce colors that are out-of-gamut for most monitors (like some cyans.) Soft Proofing
allows you to look at your image in Photoshop through the printer profile so you can see what your image
will look like when it is printed through the profile.

1. Open the image in Adobe Photoshop.
. Choose "View-> Proof Setup—~>Custom."
. Profile: Select your new, custom profile.
. Intent: “Perceptual.”
. Check “Black Point Compensation.”
. Simulate: Paper White (unchecked), Ink Black (checked).
. Leave "Preserve Color Numbers" unchecked.

8. Click “OK.”
The monitor now shows what the image will look like when it gets printed, with all of the limitations and
color adjustments that the printer and its profile will accomplish. This "soft-proof" should match fairly
closely to what is printed through the same profile.
You can also save this whole setup as a "proof setup file" with a name you choose. You can quickly view
an image through this soft proofing any time you want to see what your image will look like when printed.

NOoO OO, WN
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Technical Support

Pantone is committed to offering you immediate and polite technical support. Technical support is provided at
no charge to registered users of our products. Please be sure to provide a concise description of your problem
including your system specifics.

You can reach Pantone Technical Support several ways:
1. Telephone: 201-935-5500, Monday - Friday, 8:00 a.m. to 6:00 p.m., Eastern Standard Time

2. Fax: 201-896-0242 please ensure that you indicate whether you want a reply by telephone, fax or e-mail.
Please do not forget to include your telephone, fax number or e-mail address.

3. Online: http://www.askpantone.com
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How to Contact Us

To reach our Customer Service Department, please call 866-726-8663 (866-PANTONE). For more information
on other PANTONE Products, please visit our Web site at www.pantone.com.

NORTH AMERICA WESTERN EUROPE,
Pantone, Inc. MIDDLE EAST & AFRICA
590 Commerce Boulevard Pantone U.K,, Inc.

Carlstadt, NJ 07072-3098 U.S.A. 70 Churchill Square, Suite 11
Telephone: 201-935-5500 Kings Hill, West Malling

Fax: 201-896-0242 Kent ME19 4YU, England
E-mail: corpnj@pantone.com Telephone: (44) 1732 897677
ASIA PACIFIC Fax: (44) 1732 897687
Pantone Asia, Inc. E-mail: info@pantone.co.uk
Room 1701, 17/F D/A/CH AND EASTERN EUROPE
No. 3 Lockhart Road Pantone Europe GmbH
Wanchai, Hong Kong S.A.R. Wilhelmsplatz 11

Telephone: (852) 2724 8822 D-70182, Stuttgart, Germany
Fax: (852) 2724 8300 Tel: (49) 711 664 75990
E-mail: sales@pantone.hk Fax: (49) 711 664 75999
JAPAN E-mail: info@pantone.de

Pantone Japan Co., Ltd.

3F, Shirokane TNK Building, 1-29-4
Shirokane, Minato-Ku

Tokyo 108-0072, Japan

Telephone: (81) 3 5789 9466

Fax: (81) 3 3449 9244
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Glossary

ABCDEFGHIJKLMNOPQRSTUVWXYZ
A

Additive Primaries: Red, green, and blue light. When all three additive primaries are combined at 100% intensity,
white light is produced. When these three are combined at varying intensities, a gamut of different colors is produced.
Combining two primaries at 100% produces a subtractive primary, cyan, magenta, or yellow: 100% red + 100% green
= yellow; 100% red + 100% blue = magenta; 100% green + 100% blue = cyan. See Subtractive Primaries.

Appearance: Manifestation of the nature of objects and materials through visual attributes such as size, shape, color,
texture, glossiness, transparency, opacity, etc.

Attribute: Distinguishing characteristic of a sensation, perception or mode of appearance. Colors are often described
by their attributes of hue, saturation or chroma, and lightness.

B

Black: The absence of all reflected light; the color that is produced when an object absorbs all wavelengths from the
light source. When 100% cyan, magenta, and yellow colorants are combined, the resulting color theoretically- is
black. In real-world applications, this combination produces a muddy gray or brown. In four-color process printing,
black is one of the process inks. The letter “K” is used to represent Black in the CMYK acronym to avoid confusion
with Blue’s “B” in RGB.

Brightness: The attribute of visual perception in accordance with which an area appears to emit or reflect more or
less light (this attribute of color is used in the color model HSB—Hue, Saturation, Brightness). See Lightness.

C
Calibration: To check, adjust, or systematically standardize the performance of a device.

Characterize: To specify the parameters or performance of an instrument or method of measurement.

Characterization: The process of learning the color character of a monitor so that a profile can be created to
describe it.

CIE (Commission Internationale de I’Eclairage): A French name that translates to International Commission on
lllumination, the main international organization concerned with color and color measurement.

CMC (Color Measurement Committee): Of the Society of Dyes and Colorists in Great Britain. Developed a more
logical, ellipse-based equation for computing AE values as an alternative to the spherical regions of the CIELAB color
space.

Color Management: Matching colors between an original image, scanner, monitor, color printer and final press
sheet.

Color Model: A color measurement scale or system that numerically specifies the perceived attributes of color. Used
in computer graphics applications and by color measurement instruments.

Color Separation: The conversion of the red, green, and blue color information used in a computer into cyan,
magenta, yellow, and black channels that are used to make printing plates.

Color Space: A three-dimensional geometric representation of the colors that can be seen and/or generated using a
certain color model.

Color Specification: Tristimulus values, chromaticity coordinates and luminance value, or other color-scale values,
used to designate a color numerically in a specified color system.

Color Temperature: A measurement of the color of light radiated by an object while it is being heated. This

measurement is expressed in terms of absolute scale, or degrees Kelvin. Lower Kelvin temperatures such as 2400 K
are red; higher temperatures such as 9300 K are blue. Neutral temperature is gray, at 6504 K.
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Color Wheel: The visible spectrum’s continuum of colors arranged into a circle, where complementary colors such as
red and green are located directly across from each other.

ColorSync®: Built-in color management architecture for Apple Macintosh computers. Third-party vendors utilize the
ColorSync framework to provide device calibration, device characterization, and device profile-building methods.

Colorimeter: An optical measurement instrument that responds to color in a manner similar to the human eye - by
filtering reflected light into its dominant regions of red, green, and blue.

Colorimetric: Of or relating to values giving the amounts of three-colored lights or receptors - red, green, and blue.
Contrast: The level of variation between light and dark areas in an image.
Control Limits: The amount of acceptable variation in press capabilities over the course of a press run.

D
D50: The CIE Standard Illluminant that represents a color temperature of 5000 K. This is the color temperature that is
most widely used in graphic arts industry viewing booths. See llluminants.

D65: The CIE Standard llluminant that represents a color temperature of 6504 K.

Density: Refers to a computed number representing the ability of a transmissive material to block light, or the ability
of a reflective surface to absorb light. The more light blocked or absorbed, the higher the density.

Device-Dependent: Describes a color space that can be defined only by using information on the color-rendering
capabilities of a specific device. For example, the RGB color space must be generated by a monitor, a device which
has specific capabilities and limitations for achieving its gamut of colors. In addition, all monitors have different
capabilities and limitations, as do different scanners, printers, and printing presses.

Device-Independent: Describes a color space that can be defined using the full gamut of human vision, as defined
by a standard observer, independent of the color-rendering capabilities of any specific device.

Device Profile: Device-specific color information that is a characterization of a device’s color rendering and
reproduction capabilities. Monitor profiles, scanner profiles, and printer profiles are utilized in a color management
system such as Apple ColorSync to help the devices communicate color information with each other. Profiles are
created by calibration and/or characterization method.

E
Emissive Object: An object that emits light. Usually some sort of chemical reaction, such as the burning gasses of
the sun or the heated filament of a light bulb.

F

Fluorescent Lamp: A glass tube filled with mercury gas and coated on its inner surface with phosphors. When the
gas is charged with an electrical current, radiation is produced which in turn energizes the phosphors, causing the
phosphors to glow.

Four-Color Process: Depositing combinations of the subtractive primaries cyan, magenta, yellow, and black on
paper to achieve dots of different sizes, shapes, and angles to create the illusion of different colors.

G
Gamut: The range of different colors that can be interpreted by a color model or generated by a specific device.

Gamut Compression: Or tonal range compression. The color space coordinates of a color space with a larger
gamut are reduced to accommodate the smaller gamut of a destination color space. For example, the gamut of
photographic film is compressed for representation in the smaller CMYK gamut used for four-color process printing.
See Gamut.

Gamut Mapping: Converting the coordinates of two or more color spaces into a common color space. Often results
in tonal range compression. See Gamut Compression.
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HiFi Printing: Process printing that expands the conventional four-color process gamut using additional, special ink
colors.

» o« ” o«

Hue: The basic color of an object, such as “red,
color space, or on a Color Wheel.

green,” “purple,” etc. Defined by its angular position in a cylindrical

I

ICC (International Color Consortium): A group of hardware and software companies dedicated to the development
of a specification that is OS independent and provides the digital imaging, printing and related industries with a data
format for defining the color and reproduction characteristics of devices and their related media.

ICM: Built-in color management architecture for computers running the Windows operating system, third-party
vendors utilize the ICM framework to provide device calibration, device characterization, and device profile-building
methods.

llluminant: Incident luminous energy specified by its spectral distribution.

Intensity: Saturation or reflective energy as related to visible wavelengths of light. Reflectance of wavelengths at
high intensity generates high saturation, or chroma.

K
Kelvin (K): Unit of measurement for color temperature. The Kelvin scale starts from absolute zero, which is -273°
Celsius.

L
L*C*H: A color space that is similar to CIELAB, except uses cylindrical coordinates of lightness, chroma, and hue
angle instead of rectangular coordinates.

Light: Electromagnetic radiation in the spectral range detectable by the human eye (approx. 380 to 720nm).

Lightness: The attribute of visual perception in accordance with which an area appears to emit or reflect more or
less light. Also refers to the perception by which white objects are distinguished from gray objects and light from dark-
colored objects.

M
Monitor RGB: Same as RGB; monitor RGB simply refers specifically to the color space that can be achieved by a
particular monitor using combinations of red, green, and blue light.

N
Nanometer (nm): Unit of length equal to 10-9 meter, or one millionth of a milli-meter. Wavelengths are measured in
nanometers.

P
Phosphors: Materials that emit light when irradiated by cathode rays, or when placed in an electric field. The quantity
of visible light is proportional to the amount of excitation energy present.

Photoelectric: Pertaining to the electrical effects of light or other radiation—for example, emission of electrons.

Photoreceptor: The cone- and rod-shaped nuerons that cover the retina of the eye. Photoreceptors are excited by
visible wavelengths, then send signals to the brain where the sensation of color is perceived.

Pixel: A tiny picture element that contains red, green, and blue information for color rendering on a monitor or a
scanner.When generating colors, pixels are similar to dots of ink on paper. A monitor resolution description in terms
of pixels-per-inch (ppi) is similar to a printer resolution description in terms of dots-per-inch (dpi).

Prism: Triangular-shaped glass or other transparent material. When light is passed through a prism, its wavelengths

refract into a rainbow of colors. This demonstrates that light is composed of color, and indicates the arrangement of
colors in the visible spectrum.
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RGB: The additive primaries red, green, and blue. See Additive Primaries.

S
Saturation: The attribute of color perception that expresses the amount of departure from the neutral gray of the
same lightness. Also referred to as chroma.

Spectrophotometer: An instrument that measures the characteristics of light reflected from or transmitted through
an object, which is interpreted as spectral data.

Spectrum: Spatial arrangement of electromagnetic energy in order of wavelength size.
Standard: An established, approved reference against which instrument measurements of samples are evaluated.

Subtractive Primaries: Cyan, magenta, and yellow. Theoretically, when all three subtractive primaries are combined
at 100% on white paper, black is produced. When these three are combined at varying intensities, a gamut of
different colors is produced. Combining two primaries at 100% produces an additive primary, either red, green, or
blue: 100% cyan + 100% magenta = blue; 100% cyan + 100% yellow = green; 100% magenta + 100% yellow = red.

T
Transmissive Object: An object that allows light to pass through from one side to the other. The color of a
transmissive object results from the manipulation of wavelengths of light as they pass through.

Tristimulus: A method for communicating or generating a color using three stimuli—either additive or subtractive
colorants (such as RGB or CMY), or three attributes (such as lightness, chroma, and hue).

\'}

Viewing Booth: An enclosed area with controlled lighting that is used in graphic arts studios, service bureaus, and
printing companies as a stable environment for evaluating proofs and press sheets. Viewing booths are generally
illuminated using graphic arts industry-standard D65 lighting, and are surfaced in neutral gray colors. See D65.

Visible Spectrum: The region of the electromagnetic spectrum between 380 and 720 nanometers. Wavelengths
inside this span create the sensation of color when they are viewed by the human eye. The shorter wavelengths
create the sensation of violets, purples, and blues; the longer wavelengths create the sensation of oranges and reds.

w

White Light: Theoretically, light that emits all wavelengths of the visible spectrum at uniform intensity. In reality, most
light sources cannot achieve such perfection.
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